Lab 5: Reporting with RPE

Objectives
After completing this lab, you will be able to:
» Report on Rhapsody Models and Linked Requirements using Rational Publishing Engine

Scenario

In this Lab, you will first start the Rhapsody REST server (by starting the Report Publishing Wizard). You will then
open Rational Publishing Engine Document Studio and create a simple template to report Use Cases and their linked
Requirements. Note that this lab is only intended to show that you can report on linked requirements in RMM
models — for a more detailed guide on Reporting on Rhapsody please refer to the RPE for Rhapsody lightning lab
and the full RPE for Rhapsody course — contact your IBM representative for details.

It is assumed you are still working in Pete’s workspace — and have the model open with linked requirements loaded
— following on from the end of Lab 4.
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Task 1: Start the Rhapsody REST Server

In this task, you will launch the Rhapsody REST Server. The simplest way to do this is to start the IBM Rational
Rhapsody Report Generation Wizard — which also launches the server in preparation to generate a report. You will
cancel the report generation wizard once the REST server has started. In the next task, you will design a simple
template from scratch

1. Start the REST Server:
a. Switch to the Rhapsody client
b. From the menu, select Tools = Publish & Generate Report

c. Note that this first launches the Rhapsody REST server:

1BM Rational Rhapsody - Web Server - 0o X

rver is
alhost:2

d. Then the Report Generator Wizard is launched:
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() 1BM Rational Rhapsody Report Generator m] X
Browse to a Template
Select a Template file and click "Next"
Template: i | Browse...
Cancel

e. Click Cancel to close the RRDG report generator wizard
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Task 2: Create a New Document Template for Rhapsody

In this task, you will start RPE Document Studio, create a new blank template and add Rhapsody as a data source.

1. Start RPE Document Studio:

a. Launch Rational Publishing Engine Document Studio 2.1.2 from the Windows start menu:

®

IBM Rational
Publishing...

@ Welcome 52 |

IBM Rational Publishing Engine

New Document Template Watch @

Open Document Template Laying out a simple template
Rational Publishing Engine

@ WSRD Export.dta

@ test.dta

@ FunctionalAnalysis.dta

@ Harmony aMBSE Report.dta Adding a schema

Browse (5] Rational Publishing Engine
Starter templates
il DNG Templat ponsni Generating a document
emplates Lo BABENE T b
il DOORS Templates ' More:..
5 RQM Templates Template assistant
Get help creating a brand new template.
il DM Templates
il RTC Templates Take a tour oo

’zi Cross-product Templates Quickly build and generate documents for specific data sources by following the steps in
the Guide view.

uildit
Generate a document from a sample DNG template

2. Create a New Template:

a. Click the New Document Template link on the Welcome page:

IBM Rational Publishing Engine

New Document Template F

Open Document Template

TIP:  Alternatively, from the menu, select File & New = Document Template. If you use this option then you
will be presented with a dialog where you can fill in a Name and Description. Just click Finish (this is
metadata that may be filled in later).

b. Click OK:
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€5 Select Template Version
Template Version

Template version 2 (current RPE version)

[JRemember selection and don't ask again for new templates.

Prompt behavior for new templates can be modified from the preference pages.

3. Close Guide Views:

a. Click the X in the Guide View tab to close it

= }
[EE] Guide View 22

+5 Add data source to template

« In Document Studio, click Data > Add Data Source Schema. Click Next.

In the Predefined field, select a data source. When you select an entry, the Type field is automatically filled in

with the correct value.

In the Schema field, browse or enter the path to the XML schema. The schema tells Rational Publishing Engine

what the data that you want to use in the template looks like.
» Provide credentials and authentication type.

More information about adding a data source schema

Example

1. Open the "Add data source” wizard from the main menu.

b. Click the X in the New Document Template header to close it:
42 <New Document Template> 52

1 Add a Data Source 2  Add elements and data 3 Apply Formatting

4 Save and Run

C. Inthe blue Add data source to template popup, click Done:
+S. Add data source to template x
Click the Add Data Source schema icon in the Data Source
view to add a data source to your template
TIP:

taking up space.

4. Add Rhapsody as a Data Source:

a. From the menu, select Data = Add Data Source
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b. Click Next:

Q@ Add Data Scurce Schema Wizard 2

Add Data Source Schema Wizard
Welcome to the Add Data Source Schema Wizard

This wizard allows you to add a new Data Source Schema to the currently open Template.

') < Back Next > Finish Cancel

C. Inthe Predefined field, select Rhapsody:

@ Add Data Source Schema Wizard X

Select a New Data Source Schema

Select a Data Source schema, its type and an identifier. Optionally
provide a meaningful description. ‘

Predefined Rhapsody . : ~
Type REST v
Schema l http://localhost:27463/Rational/Rhapsody?metadata=schema [ Browse...
Name [ Rhapsody I
Description { The schema for the Rhapsody instance running on localhost. 1
User name l [
Password I [
d. Click Next
e. Click Finish

Task 3: Create a Use Case Report

In this task, you will create a simple report that outputs the names of all the Use Cases in the model. You will then
configure the document specification so that RPE can connect to and report on the currently loaded model.

1. Create a Container to Iterate Over All Use Cases:

a. Right-click inside the empty template and select Insert > Container:
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-¢- *<New Document Template> 3

Insert > 941 Paragraph

Data 5 | L Container

Debug s | I Iteration

tehi : Search 5| = Ted
Publishing Engine Document S
= Styled Text

To add Template Content pleas “— Impert Templatere 2, Hyperlink ¢D
T add new Nata Sanrce Schen - Undo Create Data Source Ctrl+Z & lmage

TIP:  You may also use the tool palette — but note that by default any tool selected stays selected until you click
the Select tool. This behavior may be switched off in the preferences

-%-- *«MNew Document Template> 3

b. Inthe Data Source View, expand the tree to Projects = Project = Predefined Queries = AllUseCases:

|S| Data Source View &3

Rhapsody

v 51”7 Projects
v 87 Project(Project)
|%& href(anyURI)
517 ActiveComponent
“ Allocations
" Block_Definition_Diagrams
” Callouts
" Class_Diagrams

[ TR BRI

«©

R N O

? PredefinedQueries
.SP.'-' AllActivities
57 AllActivities D
57 AllActors
57 AllAllocations

<
Y -

= ANUNITS
377 AllUseCaseDiagrams
v 57 AllUseCases
57 UseCase(UseCase)
87 AllValue_Bindings__Deprecated__
57 AllValue_Properties

c. Expand the AllUseCases node and drag the UseCase(UseCase) node from the Data Source View onto the
Container:
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L& Palette &2 = B ||42 *<New Document Template> 52
[+ Select o
:‘ Marquee Container

9T Paragraph

[CJ] Container v
S| Data Source View &2 | 25 &S 2B EE &
Rhapsody | ‘

type filter text

$7 AllUseCaseDiagrams ~
v 57 AllUseCases
877 UseCase(UseCase)
/7 AllValue_Bindings__Deprecated __
$7 AllValue_Properties
$7 AllValueTypes

d. Note that the Container now has the context $1
Projects/Project/PredefinedQueries/AllUseCases/UseCase:

Container Rhapsody 51 Projects/Project/PredefinedCueries/AllUseCases/UseCase

2. Add the Use Case Name:

a. Right-click the container and select Insert = Paragraph:

| -%-7 *<New Document Template> &2

Rhapscdy 1 Projects,’project,fpredefirmrh"\nmrin:/AIIIl:araeﬂdllchracﬂ

Insert > 4] Paragraph —
Data 5 %} Container
Debug 5 IO Mteration

b. Right-click the new paragraph container and select Insert = Text:

Rhapsody $1 Projects/Project/PredefinedQueries/AllUseCases/UseCase

Insert > 91 Paragraph —
Convert To > | Container

Data 5 |CJ|  Iteration M

Debug > e

l

Cod_JT s

Container Rhapsody 51 Projects/Project/PredefinedCQueries/AllUseCases/UseCase
Paragraph
Text
<text=

c. Double-click the new Text container
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d. Inthe Set Content for Current Element window, select the Data Expression tab:

Set Content for Currep @ 2ment

Simple Value | Data Expression | Script Expression |

Variables Selected data item
Attributes |

e. Expand the Attributes section
f. Expand $1 Projects/Project/PredefinedQueries/AllUseCases/UseCase

g. Select the name attribute:
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-;::j* Set Content for Current Element

l

Simple Value | Data Expression I

i

l v S1 - Projects/Project/PredefinedQueries/AllL A | Selected data item
@href

cmHeader

Script Expression

iname

concurrency
declarationModifier
descriptionHTML
descriptionRTF
descriptionText
descriptionXHTML
directoryName
entryPoints
fileName
fullPathName
iconFileName

id
isBehaviorOverriden
isComposite
isReactive
isReadOnly
isReference
isSaveUnit

isStub

isUnresolved

label

metaclass
multiplicity

name

nestinglLevel
nestingLevelAndFullPathName v

h. Click OK:

Container Rhapsody $1 Projects/Project/PredefinedQueries/AllUseCases/UseCase
Paragraph
Text

Projects/Project/PredefinedQueries/AllUseCases/UseCase/name

3. Applya Style:
a. Right-click the Paragraph and select Styles = Heading Styles 2 1:
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Rhapsody S1 Projects/Project/PredefinedQueries/AllUseCases/UseCase

Insert >
Project Convert To > se/name
Data >
Debug >
Formatting >
Style > 4y Title
Master Page > 4y HeaderCell
Search > 4y Labelltalic
4
J4  Import Template... A tabebtrong
A :
Import Template Special > (‘A Intemaliyperlink
i 4
#  Editin Zoom Editor Heading Styles 2| Ui
47 New Style... 4 2
Undo Set Content Ctrl+Z = 2 A4
7 Remove Style A A 3
Redo Ctrl+Y i

4. Record the Rhapsody REST server URI:
a. Inthe windows taskbar, switch to the Rhapsody REST server console

b. Highlight the server URI and right-click to copy it (alternatively simply make a note of it):

IBM Rational Rhapsody - Web Server

* IBM(R) Rational(R) Rhapsody(R) Web Server
* (C) Copyright IBM Corporation 2009 All Rights Reserved

* Creating server working configurtion...
C:\Users\andyl\AppData\Local\Temp\RhpWebServerConfig_155114.443414

* Launching the server...

osgi> 2017-07-31 15:51:15.968::INFO: Logging to STDERR via org.mortbay.log.StdErrLog
2017-067-31 15 5.011 NFO: jetty-6.1.x
2017-07-31 15:51:16.065::INFO: Started SocketConnector@0.0.0.0:27463

* Rhapsody Web server is running. The server address is:
. http://localhost:27463/Rational/Rhapsody/ ‘

* To stop the server, type CLOSE or EXIT and pr

C. Returnto RPE Document Studio
5. Start the Report Configuration and Generation Wizard:

a. On the toolbar, click the Configure and Generate Document button:

e Central Management Data Maste

HE BB

b. Click Yes to save the template:
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€5 Save Resource X

l.gil '<New Document Template>' has been modified. Save changes?

Yes No Cancel

€. Choose a location and a filename for the template (in this sample you can name it Use Case Report) and
click Save

d. The configuration wizard then starts:

@ Document Specification configuratior
Add Templates to this document specification

Add Templates to the document specification. After you select your templates, you can review the configuration windows for this wizard
in the Progress column. You can click Finish any time to start document generation.

v @ Templates Select templates to add

se Case Report.dta (C:\Us... From the central library

» O Data Sources*
» O Output v (13 C:IBM\RPE

oM

> (1 DNG
(1 DOORS

, (3 JsON
(22 REST

> (3 rRQM
3 RTC

Add Selected

O Summary

Templates in Document Specification

—
C:\Users\Administrator\Desktop\se Case Report.dta

e. Click Next
f. Inthe Enter a URL or filepath to the data source field, paste (or type in) the Rhapsody REST server
address:
Configure Rhapsody™:

Template:  C:\Users\Administrator\Desktop\se Case Report.dta

Description:

Manual configuration

4 ™
Enter a URL or filepath to the data source /;‘5:; 4
sl
http://localhost:27463/Rational/Rhapsody/|
User Name I
Password I
Authentication Type
Accept Header l application/xml
g. Click Next
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h. Note that four output documents will be generated (in parallel). For each output a save location and a style
sheet may optionally be selected:

Configure the output formats

Output formats are the file types you generate documents into. Configure all output formats or select only the output formats you want
to generate. You can click Finish any time to start document generation.

v v Templates Configure Word output:
Package Report.dta (C:\Us... Generate Word output
v Data Sources*
v © Output Save location: [ ‘ Browse
Html
Word Style sheet: ‘ ‘ Browse
PDF Macro name: l ‘
XslFo
O Summary, Configure PDF output:
Generate PDF output
Save location: [ ‘ Browse
Style sheet: [ ‘ Browse
Configure HTML output:
Generate Html output
Save location: Browse

i. Click Next
Jj- Note the Finish options:
Finish opticns
(® Run the document generation

(O Run the document generation and quit RPE

(O Save and close this wizard without generating the document

k. Click Finish

I.  The document is now generated in all four output formats and a results window appears:

€5 Rational Publishing Engine - Results X

IBM Rational Publishing Engine

Click on a link to open or save it

e

G

C
C

\U:

yI\AppData\local\ ...

dyN\AppData\local\ ...

dyl\AppData\Local\ ... 65

A\Users\andyN\AppData\Local

m. Click the result with the .pdf extension to open the generated PDF document:
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e Tools PDF_56fa12c0-516.. X

® B = Q R MO v - R RB@AT O 2
Bookmarks X

B B
[ Make Data Connection

|:| Place Call
[ Receive Call

R Provide Status Make Data Connection

ﬂ Supplementary Service

R Place Call
Receive Call
Provide Status
Supplementary Service
DatacCall

Voice Call

n. Close Acrobat Reader

0. Click Close to close the results generation window:

@ Rational Publishing Engine - Results X

IBM Rational Publishing Engine

Click on a link to open or save it

A\Users\ADMINI~1\AppData\ ... 87b-873b-be2780e%f665.htm
A\Users\ADMINI~T\AppData\ ... 1e0-8cf9-789c7be379¢3.doc
C:\Users\ADMINI~ 1\AppData\ ... d50-abb0-36b92d43clec.pdf
C\Users\ADMINI~ 1\AppData\ ... 4028-312¢-110efe120008.fo

€
C

Task 4: Report on Linked Requirements

In this task, you will complete this simple template — adding a container that will report on the Remote
Requirements linked to the Use Cases.

1. Add a Container to Iterate Over Dependencies:
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a. Right-click inside the $1 Container — after the Paragraph — and select Insert - Container:

Rhapsody $1 Projects/Project/PredefinedQueries/AllUseCases/UseCase

Projects/Project/PredefinedQueries/AllUseCases/UseCase/name

Insert > ﬂ Paragraph
T - -
Data , I Container
Debug s | O Iteration
Master Page y | = Text

Chilad T

TIP:  This should insert a container inside the $1 container — after the paragraph:

Container Rhapsody $1 Projects/Project/PredefinedQueries/AllUseCases/UseCase

Paragraph * AA

Projects/Project/PredefinedQueries/AllUseCases/UseCase/name

2. lterate over Dependencies:

a. Inthe Data Source View panel, scroll down and expand the Dependencies node (make sure you are
looking at the child nodes of UseCase(UseCase)

b. Drag the Dependency(Dependency) node onto the new container:
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ttai 4
ontainer Container  Rhapsody $1 Projects/Project/PredefinedQueries/AllUseCases/UseCase
Source View 5 £ 8 B RE = O |||(earagraph ~ N
& Text
e Projects/Project/PredefinedQueries/AllUseCases/UseCase/name
>
> 57 AlluseCaseDiagram Al | reonmme
v P AllUseCases

~ 57 UseCase(UseCase)
Ss href(anyURD)
ISP Activities

57 Activities D
EP Allocations

87 AssociationEnds
5P Associations

87 Attributes

s Base

1 Binding_Connectors

[S7 Block_Definition_Diagrams
57 Blacks

57 Callouts

37 Class_Diagrams

EP Classes

5 7 cmHeader(string)

57 Comments

87 CompenentFiles

577 cancurrency(string)
5 [P Conforms
> P connectors
7 Constraint_Blocks
» 187 Constraint_Properties
> 187 Constraints
> 187 ControlledFiles
5> 7 Data_Types
5 17 declarationMadifier(string)
+ BP Definedn Template Content | Zoom Ed\tor| Document Outhna|

<

i =
hiliad Dfpendsnnes 1 Properties &2 I 2 Console| | Problems‘ & Search| %5 RPE Debug|
5 7 Dependency(Dependency)

> BP Derivations Property Value

C. Inthe Select Context window, click OK:

A Select Context x

Select context

51 - Projects/Project/PredefinedQueries/AllUseCases/Us
none

©

Container Rhapsody $1 Projects/Project/PredefinedQueries/AllUseCases/UseCase

*

Paragraph Ay

Text
Projects/Project/PredefinedQueries/AllUseCases/UseCase/name

Container Rhapsody $2 Projects/Project/PredefinedQueries/AllUseCases/UseCase/Dependencies/Dependency

3. Cast Dependent Element to Requirement:

a. Inthe Data Source View, expand the Dependency(Dependency) node - then scroll down and expand the
DependsOn node:
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v 577 Dependencies

51" Dependency(Dependency)
|%@ href(anyURI)
57 Allocations

. 57 Callouts

7 Comments

7 Conforms

7 Constraints

' ControlledFiles

7 Definedin

? Dependencies

. V

«¥

M‘L”\

<9

COR

) {2 4

? Dependent
577 DependsOn
. 157 ModelElement(ModelElement)
577 Derivations

v

577 Derive_Requirements

<
.

v

b. Right-click the ModelElement(ModelElement) node and select Cast to Type:

57 Dependent
v 157 DependsOn
57 ModelElement(ModelEler
517 Search Data References

51" Derivations 4
%@ Add Special Attribute...
Edit Special Attribute...

577 Derive_Requirements
877 descriptionHTML(string)
7 descriptionRTF(string)
descriptionText(string)
57 descriptionXHTML(string) == Cast to Type.. - -

)
y IS
v

s7
v

Delete Special Attribute...

5P fullPathName(string) & -
B Hvoerlinks Remove Cast to Type
C. Inthe Select Type window, select Requirement and click OK:
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d.

42 Select Type K
Recepticon A
ReferenceActivity

Refinement

relation

RemoteResourcePackaie

Requirements_Diagram
RequirementsTable
Satisfaction

SCNode

SendAction v

@ oK . Cancel

577 Dependent
51”7 DependsOn
v 5" ModelElement(ModelElement)

& href(anyURI)

b

A,* > [82] (Requirement)
» 57 Allocations

) Aol

4. Add a Container to report on Requirements:

d.

1-18

In the Template, right-click the $2 Container and select Insert = Container:

In the Data Source View panel, expand the ModelElement(ModelElement) node and note that
Requirement appears as a node under ModelElement:
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Rhapsody $1 Projects/Project/PredefinedQueries/AllUseCases/UseCase

Projects/Project/PredefinedQueries/AllUseCases/UseCase/name

Rhapsody $2 Projects/Project/PredefinedQueries/AllUseCases/UseCase/Dependencies/Dependency

b. Drag the Requirement node from the Data Source View to the new Container and click OK in the Select
Context window:

3iner Rhapsody $1 Projects/Project/PredefinedQueries/AllUseCases/UseCase

graph * A
Text

Projects/Project/PredefinedQueries/AllUseCases/UseCase/name

Container Rhapsody $2 Projects/Project/PredefinedQueries/AllUseCases/UseCase/Dependencies/Dependency
Container Rhapsody $3 Projects/Project/PredefinedQueries/AllUseCases/UseCase/Dependencies/Dependency/DependsOn/ModelElement(Requirement)

C. Right-click the $3 Container and select Insert = Paragraph
d. Right-click the new Paragraph and select Insert - Text

e. Repeat step (d) twice more — you should now have three text elements inside the Paragraph:

“ontainer Rhapsody $2 Projects/Project/PredefinedQueries/AllUseCases/UseCase/Dependencies/Dependency

Container Rhapsody $3 Projects/Project/PredefinedQueries/AllUseCases/UseCase/Dependencies/Dependency/DependsOn/ModelElement(Requirement)

Paragraph
Text Text Text
<text> <text> <text>

5. Report the Requirement ID:
a. Double-click the first Text container
b. Inthe Set Content for Current Element window, select the Data Expression tab
c. Expand the Attributes section

d. Note that you may select attributes from any of the three contexts in the template:
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e.

f.

sntainer Rhapsody. $1 Projects/Project/PredefinedQueries/AllUseCases/UseCase

‘aragraph

Text

Projects/Project/PredefinedQueries/AllUseCases/UseCase/name

-ontainer

*

A

Rhapsod $2 [Projects/Project/PredefinedQueries/AllUseCases/UseCase/Dependencies/Dependency

Container Rhapso&}jl $3 ‘Ff'a’ojects/ProjectfPredefinedQueries,/AIIUseCases/UseCase/Dependencies/Dependen(y/'Depen(

Paragraph

Text

<text>

Expand the $3 context and select requirementUserID:

-,i: Set Content for Current Element

Simple Value | Data Expression | Script Expression

Sel¢

$1 - Projects/Project/PredefinedQueries/AllUsel
$2 - Projects/Project/PredefinedQueries/AllUse(
» $3 - Projects/Project/PredefinedQueries/AllUset

1- Set Content for Current Element

| Simple Value Data Expression ‘ Script Expression

Click OK

isStub

isUnresolved

label

metaclass

name

nestinglLevel
nestingLevelAndFullPathName
partOfTheModelKind
persistAs

persistAsGenerated
requiremenTracabilityHandle
requirementUserlD
rmmServerlD

specification

6. Report the Requirement Specification:

d.

1-20

Selected data item

requirementUserlD

Double-click the third Text container and repeat the above steps — this time selecting the specification

attribute

Double click the second Text container and in the Simple Value tab, type : (that is a space, followed by a
colon, followed by another space — this is to separate the ID and the Specification in the report):
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-éQl Set Content for Current Element

-

Simple Value ‘ Data Expression { Script Expression [

e

P

7. Generate the Report:

c. Click OK

a. On the toolbar, click the Configure and Generate Document button:
b. Click Yes to save the B~ -5 g oo

2
template: ol e

@ Save Resource X

(/- ‘\' 'C:\Users\Administrator\Desktop\se Case Report.dta' has been modified. Save
<« changes?

Yes No Cancel

C. The configuration wizard then starts
d. Click Finish

e. The document is now generated in all four output formats and a results window appears:

@ Rational Publishing Engine - Results X

IBM Rational Publishing Engine

Click on a link to open or save it

CAUsers\andy\AppData\Local\ ... ded-895f-2¢5e30805271 . htmi

N

f. Click the result with the .pdf extension to open the generated PDF document — note the linked requirements
in the report:
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Receive Call
Provide Status
Supplementary Service

DataCall

107 : The system shall admit pre-authorized vehicles
Voice Call

Make Data Connection

108 : The system shall admit unexpected vehicles when there are unutilized spaces.
114 : The system shall allocate parking spaces to guests
115 : The system shall provide information on availability of parking spaces

g. Close Adobe Acrobat Reader
h. Close Rational Publishing Engine

i. Close the REST server console window.
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